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Society for the Teaching of Psychology Project Syllabus Rubric
http://teachpsych.org/otrp/syllabi/index.php

Please indicate your rating for each item and sum the total points for each category.

Category 1: Teaching Methods
Teaching methods

Insufficient (0)

Effective (1)

Exemplary (2)

Teaching methods to enhance
student learning are minimally
consistent with best practices.

Student engagement

Insufficient (0)

Teaching methods to enhance
student learning are somewhat
consistent with best practices.
Innovation may be apparent, but
the rationale for innovative

techniques may not be apparent.

Effective (1)

Teaching methods to enhance
student learning are mostly or
completely consistent with best
practices. Innovation is also used
in accordance with best practices,
and the rationale for innovative
techniques is clear.

Exemplary (2)

Minimally engages students in the
learning process.

Moderately engages students in
the learning process.

Effectively engages students in
the learning process in a variety of
ways throughout the course.

Total points for category 1 (out of 4):

Comments:

Category 2: Learner Support & Resources

Accessibility/Universal Design for Learning (UDL; see last page for instructions on how to check a
document for accessibility issues; syllabi will now need to be submitted as Word documents so this can

be checked)

Insufficient (0)

Effective (1)

Exemplary (2)

Accessibility/UDL issues are not
addressed (e.g. no information
about resources for students with
disabilities) and syllabus is not
accessible.

Accessibility/UDL issues are briefly

addressed. Syllabus is partially
accessible.

Accessibility/UDL issues are
explicitly addressed and syllabus
is fully accessible.
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Student roles and expectations

Insufficient (0)

Effective (1)

Exemplary (2)

Course syllabus is unclear about
what is expected of students
either inside or outside the
classroom.

Faculty roles and responsibilities

Insufficient (0)

Course syllabus somewhat
identifies what is expected of
students inside or outside the
classroom.

Effective (1)

Course syllabus clearly identifies
what is expected of students both
inside and outside the class (e.g.
participation, classroom behavior,
out of class reading, discussion
board posting) OR a process for
the determination of such
expectations is clearly defined.

Exemplary (2)

Faculty roles and responsibilities
are not defined.

Interaction and communication

Insufficient (0)

Faculty roles and responsibilities
are somewhat defined.

Effective (1)

Faculty roles and responsibilities
are clearly defined. This should
include information such as
timeliness of responses to e-mails,
when graded assignments will be
returned, etc.

Exemplary (2)

Students are not provided an
opportunity to communicate with
one another outside of the
classroom. The only method
provided for communicating with
the instructor is office hours.

Students are provided
communication tools to
communicate with one another
and the instructor outside of
class. Communication tools may
be limited, poorly explained, or
not tied to student learning.

Total points for category 2 (out of 8):

Comments:

Students are provided
communication tools to
communicate with one another
and the instructor outside of class
and these tools are well
integrated into the course to
facilitate student learning.



[Type here]

Category 3: Assessment & Evaluation of Student Learning

Assignments

Insufficient (0)

Effective (1)

Exemplary (2)

Learning assignments are
minimally consistent with best
practice pedagogy in teaching the
subject matter.

Learning assignments are
somewhat consistent with best
practice pedagogy in teaching the
subject matter.

Learning assignments are mostly
or completely consistent with
best practice pedagogy in
teaching the subject matter (e.g.
active learning, problem-based
learning, laboratory work, etc. as
appropriate for the course.)

Student evaluation

Insufficient (0)

Effective (1)

Exemplary (2)

Guidelines for evaluation of
student assignments and grade
determination is unclear.

Guidelines for evaluation of
student assignments and grade
determination is somewhat clear.

Formative student performance feedback

Insufficient (0)

Effective (1)

Guidelines for evaluation of
student assignments and process
of grade determination is clear.

Exemplary (2)

Opportunities for students to
receive formative feedback about
their own performance are absent
or unclear.

Multiple forms of assessment

Insufficient (0)

Opportunities for students to
receive formative feedback about
their own performance are
infrequent and sporadic.

Effective (1)

Opportunities for regular
formative feedback about student
performance are clearly stated
throughout the course.

Exemplary (2)

Learning objectives are assessed
through limited means.

Most learning objectives are
assessed through a single form of
assessment but some learning
objectives are assessed through
multiple forms of assessment.

Total points for category 3 (out of 8):

Comments:

Learning objectives are assessed
through two or more forms of
assessment.
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Category 4: Course Design, Goals, and Learning Objectives

Rationale

Insufficient (0)

Effective (1)

Exemplary (2)

Rationale for the course and its
design are not clearly stated.

Course goals

Insufficient (0)

Rationale for the course and its
design are somewhat clearly
stated.

Effective (1)

Rationale for the course and its
design are clearly stated.

Exemplary (2)

Course goals are not clearly
defined and do not align to
learning objectives.

Learning objectives

Insufficient (0)

Course goals are defined but may
not align to learning objectives.

Effective (1)

Course goals are clearly defined
and aligned to learning objectives.

Exemplary (2)

Learning objectives are vague,
incomplete, or are not
measurable.

Learning objectives are identified
but are not consistently
measurable.

Learning objectives are identified
and consistently written in a
measurable manner.

Alignment of class time allocation with learning objectives and course goals

Insufficient (0)

Effective (1)

Exemplary (2)

The allocation of class time and
weight of assignments marginally
parallels the course objectives as
stated on the syllabus.

The allocation of class time and
weight of assignments somewhat
parallels the course objectives as
stated on the syllabus.

Alignment of learning objectives and assessment

Insufficient (0)

Effective (1)

The allocation of class time and
weight of assignments clearly
parallels the course objectives as
stated on the syllabus.

Exemplary (2)

Learning objectives are not
aligned with course and
assessment activities.

Assessment strategies

Insufficient (0)

Learning objectives are somewhat
aligned with course and
assessment activities, or
alignment is present but not
explicitly stated.

Effective (1)

Learning objectives are closely
aligned with course and
assessment activities. This
alignment is explicitly stated.

Exemplary (2)

Minimal or no assessment
strategies are used to measure
content knowledge, attitudes
and/or skills.

Ongoing strategies are used to
measure content knowledge,
attitudes and/or skills.

Total points for category 4 (out of 12):

Comments:

Ongoing multiple assessment
strategies are used to measure
content knowledge, attitudes
and/or skills.
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Category 5: Syllabus organization & design

Organization

Insufficient (0)

Effective (1)

Exemplary (2)

Much of the syllabus seems to be
under development, with some
key components of the course
identified.

Aesthetic design

Insufficient (0)

Syllabus is generally clear and well
organized. Students can
understand the key components
and structure of the course.

Effective (1)

Syllabus is clear and well
organized, including providing a
“big picture” overview. Students
can clearly understand all
components and structure of the
course.

Exemplary (2)

Aesthetic design does not present
and communicate course
information clearly.

Tone

Insufficient (0)

Aesthetic design presents and
communicates some course
information clearly.

Effective (1)

Aesthetic design presents and
communicates course information
clearly throughout the document.

Exemplary (2)

The syllabus has a marginal, or is
lacking, a warm and engaging
tone. Syllabus is written from an
instructor perspective, typically in
third person.

Formatting

Insufficient (0)

The syllabus has a moderately
warm and engaging tone. Syllabus
may be partially written from a
student perspective, typically in
first person.

Effective (1)

The syllabus has a warm and
engaging tone. This may include
things like use of positive
language and strategies for
student success. Syllabus is
written from a student
perspective, typically in first
person.

Exemplary (2)

Syllabus has some typographical
errors, misspellings, or grammar
problems, and does not adhere to
APA format for references.

Required materials

Insufficient (0)

Syllabus is generally free of
typographical errors, misspellings,
and grammar problems, and
generally adheres to APA format
for references.

Effective (1)

Syllabus is free of typographical
errors, misspellings, and grammar
problems, and adheres to APA
format for references.

Exemplary (2)

The textbook and any other
required materials are not listed,
are out of date, or are not
relevant to the topic.

The textbook and any other
required materials are mentioned
but not in sufficient detail for
students to obtain materials.
Materials may be partially

The textbook and any other
required materials are clearly
stated, relevant, and current.



[Type here]

relevant to the topic or may not
reflect current literature.

Total points for category 5 (out of 10):

Comments:

Total points (out of 42):

Overall comments (to be shared with submitter; send any private comments to the Project Syllabus
director via e-mail):

This rubric was based on the Rubric for Online Instruction developed by Chico State University
(http://www.csuchico.edu/eoi/) as well as a variety of other sources (see list of references on the
Project Syllabus web page: http://teachpsych.org/otrp/syllabi/index.php).
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CREATING ACCESSIBLE MICROSOFT WORD 2013

DOCUMENTS (WINDOWS)

Heading Styles

Create a uniform heading structure through use of styles
in Word. This allows screen readers to navigate a document
and improves accessibility for cveryonc.

Adding and Editing Headings

1. Selecr the text and choose the appropriate style undcr
Styles on the Home ribbon. (c.g., “Heading 17)

2. Headings 1, 2, or 3 can also be assigned using CTRL +
ALT + 1, 2, or 3, respectively.

Zwvo§>ma§9>mmcn.bmm_nnnmpwwcnno>m_u_.
TNormal - TNoSpac. Headingl | Heading2 | Heading 3 Title W

Styles =

Alternative Text for Images

Images can be given appropriate alternative text in Word.
This alt text is read by a screen reader in a2 Word file and
should remain intact when exporting to HTML or PDE

Adding Alt Text
1. Right-click on the image and
choosc Format Picture.

Format Picture T

o @

2. Sclect the Layout & EIS R
3.6\.&\:.2 icon and choose . “-.-ﬂ_.
Alt Text.
3. Enter appropriate alt text Desuistion
only in ﬁmn Description ficld ALTERNATIVE TEXT HERE

(not the Title ficld).

Columns

When creating columns, always use true columns, not
columns created by hand with the Tab key.

Creating Columns
1. Sclect Page Layout on the ribbon.

2. Sclect Columns under Page Setup and choosc the
appropriate number of columns.

HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES M|

ﬁ ﬁ;.# _ Y = Beesks - Indern Spacin

Rvai o__Ir_ ; Hline Numbers - 4 Lefe 07 2156

o Onton | 20 f* Hyphenation= 24 Right: 0" Tlia an
Page Se1 a Paragraph

© 2014 Project GOALS All rights reserved.

Contact us at goals@ncdae.org or #435.797.3381

Lists
Usc true numbered and bulleted lists to cmphasizc a point
or a sequence of steps.

Creating Lists

1. Sclect the Numbered List or Bulleted List option on
the Home ribbon, under the Paragraph scction.

HOME INSERT DESG PAGE LAYOUT REFERENCES MAILINGS REVE|
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Links

Word automatically creates a hyperlink when a uscr pastes
a full URL onto a page. These may not make scnse to screen
reader uscrs, so more information is needed.

Adding Hyperlinks
1. Select the text you want linked, right click, and sclect
Hyperlink or CTRL + k.

2. Make surc the text in the Test to Display ficld is a
Bnuzm:m».:_ n_nmn_,:io: and typc the link URL in the
Addpress bar.

Edit Hyperiink : e
Link to: Tost 10 disgtay: DCOAE brmsintter [ saeenmp..
i fosker | | Wy Documenty E .uhu @E
o Web Page 1 Camtasia Qude + || Bgotmak..
" ﬁ 4 Custom Office Templates r
(%) } Domnlosd [ torget trame.. |
Place in 2
£t [ox 1| conces ||
Data Tables

Accessible tables nced a clear table structure and table
headers to help guide a screen reader user.

Creating Tables
1. Select the Insert tab on the 8 coverpage 3 &

ribbon, then sclect Table > [ 5a 7se e Dole
Insert Table. o i
Fages Taoes .

‘a

.o
SSGOALS
2. To add table headers to the first row, sclect Table Tools>

Layout on the ribbon, then choosc the Repeat Header

Rows option in the Data scction.
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Options in the Design tab may be used to change appearance
but will not provide the necessary accessibility information.

Accessibility Checker
Word includes an accessibility resource that identifies
accessibility issues.

1. Sclect File> Info.

2. Sclect the Check Info
for Issues button ——
and choose Check AR
Accessibility. Dot

3. The Accessibility
Checker task panc

D Irspect Document

| Rafinr pabbihing St e, b
will show accessibility 3 St gy o)
errors, warnings,
and tips on how

to repair the crrors.
Select specific issucs
to scc Additional
Information ar the

bottom of the task panc.
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Other Principles

* Ensurc that font size is sufficicnt, around 12 points.
* Provide sufficient contrast.

* Don't usc color as the only way to convey content.
* Provide a table of contents for long documents.

* Usc simple language.

For a digital version go to ncdae.org/resources/cheatsheets

Made possible by a grant from the Fund for the Improvement of Postsecondary Education (FIPSE), US Department of Education. No official endorsement implied.



